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Introduction 
Welcome to Corporate Taxprep! 

This Quick Start Guide is designed to acquaint you with the Corporate Taxprep program as well 
as give you tips on how to use it. This is not an in-depth guide; please refer to the Help any 
time for tax or technical assistance when you are in the program. For information on tax and 
form changes, please refer to the Release Notes for each version. 
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Overview 
Different Views 
The Corporate Taxprep program is comprised of several different views that allow you to 
perform different functions within the program. 

The Corporate Taxprep Views 

 
Professional Centre provides important information about the program, tax 
news and links for customer service and support. 

 

Client Manager displays all of your tax returns. You can use it to open and roll 
forward files, print returns, EFILE, create reports and perform other functions 
that help you to manage the tax preparation process. 

 
Tax Return is where you prepare the return. You can print or transmit any open 
tax return from here. 

 
Print Formats is where you define the print settings for each form included in 
the tax return, such as the number of copies and the printer selection.  

 
Preparer Profiles is where you enter data that you want by default in every 
return. 

 

Filters and Diagnostics contains predefined and customized filters and 
diagnostics that you apply in the Client Manager or in the diagnostics pane to 
generate reports or identify certain situations.  

 
Letters and Labels view is where you create customized templates for letters 
and labels. 

 
Rate Tables is where you establish the values and rates used in the current year 
tax return.  

 
EFILE Log lists all the transactions related to electronically filed returns and 
provides follow-up options and reports. 

 EFILE Archive stores archived transactions from the EFILE Log. 
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Accessing Views 
The various views in the program are accessed using the Menu button.  
 

 
 

 

 
 
You can also access the views using the 
applicable shortcut key combinations. 

 
The name of the current view appears beside the Menu button.  

 
 

Toolbar 
The toolbar provides quick access to the most common commands in the program.  

 
 

The icons displayed on the toolbar will vary. For example, different icons will be displayed 
when you are viewing the Form Manager vs. when you are viewing a form.  

The toolbar icons will also vary from view to view, as some commands may not be applicable 
in all views.  



Corporate Taxprep   Quick Start Guide 

7 

The Professional Centre 
The Professional Centre is a dedicated Web page that provides the latest information on 
Corporate Taxprep, including automatically alerting you to any program updates. 

On the Professional Centre you will see a link to the Help Centre and to support documents 
such as the Release Notes, as well as links to training resources and to the searchable 
Knowledge Base. The Professional Centre also provides information on how to contact Taxprep 
for customer service and support.  

For more information on the Taxprep Help Centre and the Knowledge Base see page 38.  

Default View 
By default, when you launch Corporate Taxprep, the Tax Return view will be displayed. 
However, in Tools/Options and Settings (see below), you can configure the program to 
automatically open in the Client Manager or EFILE Log. 

Setup 
Options and Settings 
You can configure most aspects of the program using the Options and Settings command on 
the Tools menu.  

Note: If you are using the Network version, some options and settings may be pre-configured 
for various user groups. Check with your Network Administrator for more information. 

Click the section title to see a description of the options and settings contained in each 
section. Any changes that you make will be saved automatically when you click OK or Apply. 

Note: The options and settings are saved on your workstation and are unique to you. 

Preparer Profile 
Your preparer profile may be configured in the Preparer Profiles view. You can have multiple 
preparer profiles.  

Click New to create a preparer profile. If you do not create a preparer profile, the program will 
use the defaults for the various options presented in the Preparer Profiles view. 

The Preparer Profiles edit screen has six tabs: Profile, Staff, Authorization Forms, EFILE, Client 
Letter and Interest. 

Click the Profile tab to enter information about your firm and your preferences with respect to 
preparing your returns. 

Click the Staff tab to enter the names of the staff and partners using Corporate Taxprep for 
purposes of selecting these names in each return for tracking purposes.  

Click the Authorization Forms tab to enter information and modify settings used when 
completing and filing a federal Representative Authorization Request, the MR-69 form 
(Québec), or the Alberta Consent form (AAUT). 

Click the EFILE tab to modify the settings used for electronic filing of T2, CO-17 and AT1 returns 
as well as the RC4649, T106, T1134, T1135 information returns and special election forms. 

Click the Client Letter tab to configure your client letter options, including selecting whether 
or not the Filing Instructions should be addressed to the corporation, and entering any 
standard opening and closing paragraphs. 

Click the Interest tab to configure your options with respect to the calculation of interest and 
penalties on late-filed returns. 

 TIP 
When creating 
additional preparer 
profiles, you can 
make a copy of any 
existing profile and 
simply change 
selected fields. 
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The first time you save a specific preparer profile, the program will display the Preparer 
Profile Properties dialog box. 

You can enter a new name and description for your preparer profile. Click Default if you want 
that preparer profile to be used by default. You can change the information in this dialog box 
at any time using the Set Properties command. Click OK to return to the Preparer Profiles 
view. 

All of the profiles that you create will appear in the list of Preparer Profiles. A check mark will 
appear beside the default Preparer Profile. 

For more information on the Preparer Profile, refer to the Help. 

Preparing Returns 
Taxation Years Covered  
Each version of Corporate Taxprep is designed to process corporate tax returns for a specific 
range of taxation years, depending on the form approvals received by the various 
governments. 

Corporate Taxprep 2025 v.1.0 can be used to process returns that cover a taxation year 
beginning on or after January 1, 2023, and ending on or before October 31, 2025. 

Check the Release Notes to identify the taxation years covered by the version you are currently 
using. 

Prior Version Coverage 
If you need to create or modify a return for a taxation year not covered by the current version, 
you must use the appropriate prior version. 

To determine which version is required for a specific taxation year, search for the topic 
“Version Coverage” in the online Help. 

Roll Forward 
If your firm has already been using Corporate Taxprep, the files from the prior taxation year 
can be rolled forward. You may also be able to roll forward data from files created using 
another T2 program. 

What is a Roll Forward? 
The roll forward procedure creates a new file for the current taxation year based on what was 
in last year’s return to avoid re-entering information that was gathered in a prior year. 

When a file is rolled forward, the permanent information (e.g. corporation name, address, 
signing officer information, etc.) is retained and the closing balances of carryforward amounts 
(e.g. undepreciated capital cost, unutilized prior year losses and RDTOH amounts) become the 
opening balances. 

In addition, if the file was prepared using Corporate Taxprep last year, the data entered for the 
prior year’s return is retained for comparison purposes.  
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Using the Roll Forward 
To roll forward files from a single folder, proceed as follows: 
1. On the File menu, click Roll Forward. The Roll Forward dialog box displays. 
2. Browse to the folder where the prior year client files that you want to roll forward are 

located. Then select the desired file(s). 
3. Click OK. 
4. The Roll Forward dialog box will be displayed on the screen. In the File Options and Data 

Options tabs, select the desired options.  
5. Click OK to start the roll forward process. 

When a single file is rolled forward, it opens in the Identification form. 

Note: If you have opened the prior year file (e.g. to ensure you have selected the correct file), 
you must close it before you can roll forward the file. 

Rolling forward files from Multiple Folders 
If your prior year files are in different folders, you can use the Client Manager to view a list of 
all of last year’s files from multiple locations and select the files that you want to roll forward.  

Converting files from other programs 

  

You can convert and roll forward files from other 
programs in the same manner as you roll forward 
Corporate Taxprep files. 

If you are rolling forward these from the Tax Return 
view, select the appropriate file type from the drop-
down list in the bottom right corner of the Roll 
Forward dialog box. 

If you are converting files from other programs using the Client Manager, select the 
appropriate file type from the list beside the Files to Roll Forward filter. 

 

Opening Files 
To open an existing file, or a file that has been rolled forward, proceed as follows: 
1. On the File menu, select Open. 
2. You can open as many data files as you want. 
To open several returns or client files, proceed as follows: 
1. In the Client Manager, select the returns or the client files you want to open. 

In order to quickly select all returns displayed on the Client Manager, press Ctrl+A. 
2. On the File menu, click Open. 

Opening Files Created with a Prior Version 
You can open files created with prior versions of the program. If the taxation year is covered 
by the current version, you will be given the option to recalculate the return using the current 
version. If you reply “No,” the return will open in “data locked” mode, and the data will be 
unchanged. Note that once the return has been saved in the current version, you will no 
longer be able to open the file using a prior version. 

If the taxation year of the return is not covered by the current version, the file will be opened 
in read-only mode. You will still be able to open the file using the appropriate prior version 
(e.g. to adjust data to reflect a reassessment). 

 TIP 
If you have more 
than one version 
of the program 
installed, open 
your data file by 
double-clicking it. 
The appropriate 
version of the 
program will 
launch based on 
the tax year. 

 

javascript:kadovTextPopup(this)
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Opening Other Files Using Shortcuts 
You can add shortcuts to other client files within the current file, including files that were 
created in an earlier version of the program. Once created, the shortcut will allow you to 
quickly access another client file. 

When rolling forward the prior year client file, a shortcut to the client file will be automatically 
created. This shortcut will be available using the Prior Year/Open last year’s client file 
command on the File menu or by pressing Ctrl+E. 

You can also modify or delete existing shortcuts and create new shortcuts manually. 
Note: If the file that you are opening using a shortcut has a tax year within the coverage period 
of the current version, the file will be opened in the current version. However, if the tax year 
precedes the current version, then the appropriate version of Corporate Taxprep will be 
launched provided it has been installed and is accessible. 

Client Manager 
The Client Manager provides information on all of your client files. 

It is used when you want to perform a function on multiple returns, such as: 
• opening returns; 
• rolling forward data; 
• recalculating returns; 
• importing data;  
• generating reports on your clients; 
• printing returns; 
• printing letters and labels; 
• electronic filing. 

The Client Manager is also a useful tool for easily locating the files that you want to open. You 
can sort your returns by any field and find a return by typing the corporation’s name. 

For more information on the Client Manager, refer to the Help. 

Starting a New Return 
Click New to start a new return. 

Corporate Taxprep will open the Identification form. Ensure that all applicable information is 
entered on this form, as data from the Identification form is used throughout the return.  

If you are using CCH® iFirm®, you can sync certain identification data between the Corporate 
Taxprep client file and your client contacts in CCH iFirm. Refer to the Help for more 
information. 

History of Prior Tax Years 
At the bottom of Form Non-Capital Loss Continuity Workchart (Jump Code:4N) is a History of 
Prior Tax Years. When you create a new return, Taxprep will automatically calculate dates for 
20 prior tax years in the History table based on the default tax year. 

If the corporation’s tax year commenced on a different date, use the option provided to 
recalculate the dates of the prior tax years from the start date of the current tax year back to 
the date of incorporation. Modify the dates as needed to account for any short tax years.  

This will allow the program to correctly determine the tax year in which any losses or credits 
(e.g. investment tax credits) will expire and ensure that the correct information is rolled 
forward. 

 TIP 
In tables like the 
Client Manager and 
Form Manager, you 
can select items in 
several ways: 

• To select 
adjacent items, 
click the first 
item, and then 
press Shift while 
clicking the last 
item. 

• To select non-
adjacent items, 
click the first 
item, and then 
press Ctrl while 
clicking each 
item. 

• To select the 
entire list, click 
the first item, 
and then press 
Ctrl, Shift and 
End 
simultaneously. 
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Accessing Forms 
There are two different methods for accessing forms in Corporate Taxprep: Selecting forms 
from the Form Manager or using Xpress (for more information on Xpress, see page 12). 

Form Manager 
To view the Form Manager, press F4 or click the Form Manager icon on the toolbar. 

The Form Manager provides easy access to the various forms available in Taxprep. 

Simply select the form that you want, then press Enter or double-click to open the form. 

To help you locate your forms quickly, Taxprep assigns a jump code for each form. Simply start 
typing the jump code and Taxprep will search for that code.  

Jump Code conventions: 

• Federal return (i.e. Schedule 200): J (for Jacket) 
• Provincial returns: 1st letter of province + J (e.g. QJ for the CO-17 return) 
• Federal schedules: Schedule number (e.g. 8 for Schedule 8) 
• Provincial equivalent schedules: 1st letter of province + federal schedule number (e.g. Q8 

for Québec equivalent of Schedule 8) 
• Provincial income tax forms for agreeing provinces: Federal schedule number (e.g. 500 for 

Form 500 - Ontario Corporation Tax Calculation) 
• Forms for non-agreeing provinces: 1st letter of province + provincial schedule number (e.g. 

A16 for Alberta Schedule 16) 
• Worksheets: Acronym or short form (e.g. ADV for “Advertising – Non-Canadian advertising 

expenses”) 

Note: “Agreeing provinces” refers to the provinces for which the federal government collects 
corporate income tax. At present all provinces except for Alberta and Québec are agreeing 
provinces.  

If you don’t know the jump code of a form, you can use the “Search” field on the toolbar (or 
press Ctrl+F). Simply enter your search text and the program will display all of the forms that 
contain that search text as part of the jump code, title or description.  

Once a form is open, a tab for the form will appear at the top of the form display. Click any 
form tab to view an open form. Press Esc to close the form and remove the form tab. 

You can also access forms by drilling down from a form using the Expand command (e.g. 
beginning in the T2 Jacket and expanding). 

You can use F6 to toggle back and forth between the current form and the last form viewed. 

Use F8 to toggle between federal and provincial equivalent forms. 

Press F4 to toggle between the Form Manager and the open forms. 

Note: The program will retain information about what forms were opened and where the 
cursor was positioned, so that the next time the file is opened (by any user), the same forms 
will be opened automatically if this option is selected in the options and settings of the user 
who opens the file.  

 TIP 
As most returns 
often require many 
of the same forms 
and fields as the 
prior year, using 
Xpress is an 
excellent way of 
quickly accessing 
the fields that you 
are most likely to 
need to complete 
for the current 
year. 

 TIP 
Once you have 
finished work on a 
specific data file, 
close the file to 
avoid entering 
data into the 
wrong return. 
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Xpress 
Taxprep Xpress allows you to view the data in the return in a table format. You can select a 
filter to limit the data that you are viewing (e.g. only view the data entered in the current 
year). 

The data in the Xpress table is fully interactive with the data in the forms. Any change made on 
the form will be immediately reflected in the Xpress table and vice versa. 

Instead of jumping from form to form to enter data, with Xpress, you can simply scroll through 
the list of data entered in prior years and type in this year’s amounts. 

On the View menu, click Xpress (or click the Xpress icon on the toolbar) to display Xpress. You 
have two options for displaying Xpress: Dock and Float. 

If you choose Dock, Xpress will be displayed in a pane at the bottom of the Taxprep window. If 
you choose Float, Xpress will be displayed in a separate window which you can reposition (e.g. 
onto a second monitor). 

Xpress can also be a useful tool for reviewing the return. See page 24 for more information.  

 

Expand (F9) 
When you are on a form, you can move to another related form by “Expanding.” 

Expanding allows you to move from one form to another without first going to the Forms 
Manager. You can expand from any cell with an arrow symbol beside it to display that cell’s 
source form. 

Access a source form from an expandable cell as follows: 

• on the Forms menu, click Expand. 

• right-click and then click Expand on the shortcut menu. 

• press F9. 

• double-click the cell.  

Cell Display 
Corporate Taxprep uses flags to identify the properties of the cells. The colours indicate if the 
cell is calculated, calculated but overrideable, or input. The following are descriptions of the 
most common cell displays: 

Cell Type Appearance Definition 

Input cell 
 

Black text on white 
background  

Data entry cell. 

Protected cell 
 

Black text on same colour 
background as the form 

No input or override is possible. 

Overrideable cell 
 

Black text on grey 
background 

Calculated cell where content can be 
overridden. 

 TIP 
When you display 
a form that is 
particularly long, 
such as T2 - 
Corporation 
Income Tax Return 
(Jump Code: J), you 
can access a 
specific section of 
the form rapidly 
by right-clicking 
on an area of the 
form that is not a 
cell and then 
clicking the name 
of the section you 
wish to view. 
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Cell Type Appearance Definition 

Expandable cell 
 

Blue arrow pointing into the 
cell. 

Cell in which the content comes from 
another form. 

Overridden cell 
 

Black text on pink 
background  

Calculated cell where content has 
been overridden. 

Rolled Forward 
Cell 

 
Blue text on white 
background 

Cell that was rolled forward from the 
prior year 

Cells with data 
entered last year 
but not this year 

 
Black text on yellow 
background 

Cell in which data was entered last 
year but no value has been entered or 
rolled forward in the current year 

Cells with 
downloaded 
data 

 
Cell in which data has been 
downloaded from the CRA via 
TaxprepConnect 

Cells in which 
downloaded 
data has been 
overwritten 

 Cell in which data was first 
downloaded from the CRA using 
TaxprepConnect and whose content 
was then replaced by a direct input. 

Cells with review 
marks 

 
Red indicator on the right 
side of the cell. 

Cell that has been marked as part of a 
review. Five types of review marks are 
available. 

Cell with 
diagnostic 

 
Red triangle in the upper 
right corner  

Diagnostic applies. 

Cell with 
attachment 

 
Paper clip in the upper left 
corner 

Cell to which a note or schedule has 
been attached. 

Cell with tax link 
 

Blue triangle in the lower 
right corner  

Cell with a InfoConnect Tax Hint and 
link to a Tax Research product.  

Note: The text and background colours mentioned above are configurable on the Options – 
Colours window under Tools / Options and Settings. 

Entering Data 
Amounts must be entered in whole dollars only. 

If an amount is a negative number, precede it with a “-”. 

Data can be entered into overrideable cells, simply by entering the data. The program will 
prompt you to confirm the override before displaying the new value. 
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Special Forms 
Multiple copy forms  
There are a number of tax forms for which you may require several copies. For example, on the 
data entry screens for capital cost allowance (CCA), you will require a separate copy for each 
CCA class. 

Taxprep allows you to create multiple copies of these forms. A Multiple Copy toolbar appears 
at the top of each multiple copy form to simplify navigation between copies. 

 

 Displays the first copy of the form. 

 
The Previous button displays the previous copy and the Next button displays the next 
copy of the form. 

 Displays the last copy of the form. 

 The Copies list provides access to all the created copies of the form. 

 
The New button creates a new copy of the form and the Delete button deletes the copy 
displayed on the screen. 

 
The Search button allows you to search for a specific copy of the form by entering any 
part of the description. 

Multiple Copy History Forms 
Schedules 53 and 54 are examples of multiple copy forms in which each copy (except for the 
first one) contains data from previous years. This group of copies allows you to save the 
historical data used to calculate the current year balance. 

 
When a return is rolled forward, a new copy of the schedule will be created automatically for 
the immediately prior taxation year and the data from that year will be carried forward to this 
new copy. The first copy represents the current taxation year and its contents are determined 
from the data in the current return. 

For more details, please refer to the Help. 
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Multi-Line Tables 
Several forms contain an unlimited number of lines. For example, Schedule 2, Schedule 3, and 
Schedule 21 all contain this type of table. 

A new line (or set of lines) is automatically added as soon as data is entered. 

You can also use the Add button to create a new line or lines. Use the Delete button to remove 
a line.  

Related and Associated Corporations Workchart 
A number of different federal and provincial forms require you to report information on 
related and associated corporations. 

In order to minimize the duplication of data, information on the various related and 
associated corporations in the corporate group is entered in the Related & Associated 
Corporations Workchart (Jump Code: 9W). This workchart can be accessed by expanding from 
any of the forms that utilize this information (e.g. Schedule 9 or 23) or directly from the Form 
Manager. 

The first copy of the R&A Workchart is reserved for the filing corporation and much of the 
information will be updated automatically from elsewhere in the return. 

The second and subsequent copies are used to record information on the remaining 
corporations within the group. 

The data entering in the R&A Workchart can be imported from one data file to another using 
the T2 Data Connection feature. See page 19 for more information on this feature. 

Attachments 
You can create both attached notes and attached schedules. Once a note or schedule has 
been attached to a cell, a paperclip will be displayed in the left corner of the cell. 

 
Attached Notes  
You can attach a note to any type of cell by right-clicking then selecting Attach Note. 

If you want the note that you create to be rolled forward to next year’s return (e.g. because the 
note may also be applicable next year), select the following option:  

    
When you hover your pointer over a cell that has an attached note, the note will appear. 

Attached notes are summarized on the form Attached Notes - Summary (Jump Code: ATTN) 
which can be printed along with the return. The notes can be sorted according to the order the 
forms appear in the Form Manager. The name of the user that last edited the note, as well as 
the date the note was last modified, will be displayed on the Attached Notes – Summary. You 
can also navigate to a cell that has a note attached by double-clicking the name of the cell 
associated to the note from the Attached Notes – Summary. 

Attached Schedules 
The Attached Schedule with Total (Jump Code: ATTS) is a multiple copy form. Each time you 
attach a schedule to a cell, a new copy of the attached schedule is added to the form and 
linked to this cell. You can also add copies that are not linked to any cell. 

 TIP 
Jump to ATTS on 
the Form Manager 
to access all of the 
attached 
schedules. Use the 
Multiple Copies 
toolbar to find a 
specific 
attachment. 
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To attach a schedule, proceed as follows: 
1. Select the cell to which you would like to attach a schedule. 
2. On the Edit menu, select Attach Schedule. 

For more information on the Attached Notes and Schedules, refer to the Help. 

Client Letters  
Previewing a Letter 
Letter templates are linked to letters on the Form Manager. When you print or display a letter 
from the Form Manager, the template contents is merged with the data in the active tax 
return. The resulting document is a letter that contains information specific to each client’s 
situation. 

You can view the letter by entering the jump code for that letter preview similar to accessing 
any other form. 

Templates Included 
A letter template called Client Letter - Filing Instructions (Jump Code: CLF) is included in 
Corporate Taxprep. This template lists all of the various returns that the corporation is 
required to file along with the filing due date, the address to which the return is to be 
submitted, the signing instructions and the amount of any balance owing or refund.  

The Filing Instructions will indicate any forms that have to be paper-filed (e.g. AgriStability 
forms) or forms that have to be signed and retained to be produced upon demand.  

Corporate Taxprep also includes the predefined templates: Client Letter – Filing instructions 
for the AgriStability and AgriInvest program forms (Jump Code: CLA), Client Letter – 
Engagement Letter (Jump Code: ECL) and Client Letter – Covering Letter to Accompany a 
Payment of Income Tax to the CRA (Jump Code: Letter P). 

In addition, there are several blank letter templates provided that can be used to create your 
own covering letter, marketing letters, request for information, etc.  
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Changing the Contents of the Letter 
You can change the contents of a letter template for a specific client in two ways: 
• modify the data in the Client Letter Worksheet; or 
• edit the Letter Preview. 

Client Letter Worksheet 
The Client Letter Worksheet (Jump Code: LW) is used to select and modify the information that 
appears in the Client Letter – Filing Instructions or other client letters.  

The worksheet indicates the various forms that need to be submitted to the tax authorities 
and/or retained as well as the applicable due dates. This information can be overridden if 
desired. 

Certain options in the worksheet are updated from the Preparer Profile (e.g. the style of 
salutation) and can also be overridden. 

Moreover, you can enter additional information for the current return, such as the name of a 
specific partner/staff member to appear at the bottom of the letter in addition to the firm 
name. 

You can also enter optional opening and closing paragraphs specific to this return. 

If you are using any of the blank letter templates provided, indicate which additional letters 
should be printed with the return. This selection can be configured in the Preparer Profile, or 
can be entered directly on the Client Letter Worksheet using overrides.  

Any data that you enter in the Client Letter Worksheet is saved with the return. 

Editing the Letter Preview 
You can edit the letter preview to temporarily change the letter generated from your template. 
You can add, delete or modify the text in the letter as well as pasting in text from another 
source (e.g. a Word document). However, the edit will only stay in effect while you are in the 
letter preview. The next time that you access the letter preview, your edits will be lost, as the 
preview will be re-generated from your template to ensure that it reflects the latest data in 
the return.  

You can, however, save your edited version of the letter preview to an .rtf file which is 
compatible with word-processing programs, using the command Save Letter As on the File 
menu.  

You can also print the edited letter preview using the Print Form command similar to any 
other form. 

Changing all Client Letters 
If you want to make a change for all of your client letters (e.g. change the wording of a specific 
paragraph, or add the firm’s logo to the letter), you can edit the appropriate letter templates.  

For information on editing the letter templates, refer to the Help. 

Transferring Data  
Importing and Exporting  
Corporate Taxprep supports a number of different types of importing and exporting: 

• Importing downloaded tax data via TaxprepConnect 

 TIP 
If you wish to use 
the Filing 
Instructions 
internally or if the 
instructions will 
accompany a 
covering letter, you 
can suppress the 
corporation’s name, 
address and 
salutation at the 
top of the letter. 
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• Importing GIFI data; 
• Importing Corporate Group Data; 
• Importing and/or exporting data between a Taxprep file and a generic file type compatible 

with other applications, such as a spreadsheet;  
• Exporting data to create a Taxprep Forms file; 
• Syncing data with CCH iFirm. 

TaxprepConnect 
You can use the command TaxprepConnect Download on the File menu to download tax data 
(e.g. loss carryforwards, GRIP balance, tax return data) from the CRA. The information that can 
be downloaded from the CRA is the same data that is viewable in My Business Account. 

You may only download data for one client file at a time.  

The available downloaded data includes return balances, such as RDTOH, ERDTOH, NERDTOH, 
GRIP, losses, CDA (where available), account balances and corporate addresses. In addition, 
you can select a recent tax year end in order to download the assessed return data for that 
taxation year. This may be helpful for a new client where the prior year data file is not 
available.  

You can also use this service to download a Notice of Assessment or Reassessment for any of 
the tax years that CRA indicates are available for that corporation. (If you have recently 
electronically filed the return, it may take up to 3 days for the NOA to be available for 
download). When you download a Notice of Assessment (NOA) through TaxprepConnect, it will 
be downloaded in HTML format. Click the View button on the Form TaxprepConnect Download 
(Jump Code: CONNECT) and the NOA will open in your default browser. Note that only the most 
recently downloaded NOA will be stored in your client file. See page 27 for information on 
printing the NOA.  

In order to download tax data or an NOA from the CRA, you must be the authorized 
representative for the corporation and have online access to information through the 
Represent a Client service. Taxprep will launch the CRA’s T2 Auto-Fill service and you will need 
to login using your CRA login and password or using partner credentials. Once logged in, the 
program will transfer the BN of the corporation to the CRA. You can then choose which data 
you wish to download to Taxprep. 

Once the data has been downloaded, you can review it on the Form TaxprepConnect Download 
(Jump Code: CONNECT) and then, where applicable, select the data that you want to transfer to 
the tax return.  

Cells that have tax data transferred from the Auto-Fill form to the return will be identified with 
a green background. If any of this data is changed after it has been transferred to the return, 
the cell background will change to purple.  

You may download data using TaxprepConnect multiple times (e.g., to download balances 
prior to preparing the return and then to download the NOA once the return has been 
accessed). For more information on using TaxprepConnect, refer to the Help. 
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Importing GIFI Data 
The General Index of Financial Information (GIFI) data can be imported from many popular 
Canadian accounting or working paper programs. 

To import GIFI data, click Import Data/GIFI file on the File menu. Note that this command is 
used to import data with a .gfi or .txt file extension that is in the GIFI format specified by the 
CRA. 

If your data is not available in GIFI format, you may still be able to import it by using an .xls or 
.csv file (see page 22 for more information on importing other file types). An Excel template 
that can be used to import GIFI data is available on the Taxprep Web site. 

Importing Corporate Group Data 
About the T2 Data Connection 
You can import corporate group data from one return to another using the T2 Data Connection 
feature. 

Once you have completed the corporate group information within one file, you can import that 
data (including allocations between corporations) into any other file in the corporate group. 
You can use this feature regardless of whether or not you entered the data directly into the 
R&A Workchart (e.g. for returns being prepared elsewhere) or whether you obtained it by 
linking with the source file. 

How to use T2 Data Connection 
Step 1 – Prepare each return in the group 
Roll forward and prepare each of the tax returns in the group as far as possible aside from the 
information on related and associated corporations. 

Step 2 –Complete the R&A Workchart 
If you have access to the returns for other corporations in the corporate group, you can link to 
these files to automatically transfer information into the R&A workchart. Otherwise you can 
manually enter the relevant information in the R&A workchart. 

Select one of the returns to use as the initial return for purposes of identifying all of the 
returns in the group. 

Access the R&A Workchart (Jump Code: 9 WORKCHART). 

Linking the Returns 
For each corporation already listed in the workchart, if you wish to link to the actual return, 

click  beside the field for the “Location and name of the linked file,” then select the 
appropriate file for the current taxation year. 

If you create a new copy of the R&A Workchart, Taxprep will automatically prompt you to 
create the link to the appropriate file for the current taxation year. 

All of the data that will be imported for that corporation will be displayed. You can suppress 
any of the data by clearing the appropriate check mark. 

 TIP 
If you don’t have 
access to certain 
tax returns for the 
group (e.g. because 
they are being 
prepared by 
another office or 
firm), you can 
simply enter the 
relevant R&A 
information 
directly into the 
R&A Workchart of 
the initial return. 
All of the R&A data 
entered can then 
be imported into 
each of the other 
returns in the 
group. 
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Note: You may select the file location for each corporation in the group in one data file. The 
links will then be imported along with the data into subsequent returns (see Step 5). 

Step 3- Determine the allocations between the returns in the group 
For each relevant form applicable to the corporate group (e.g. Schedules 23, 49, CO-771.1.3, 
etc.), allocate the amounts (if necessary) for each corporation.  

Using the Allocation Scenarios (Optional) 
If you have linked to other data files for the corporate group, you can view the impact of the 
proposed allocation on all corporations (not just the filing corporation) by clicking the 
Calculate button on any allocation schedule.  

 TIP 
You can easily view 
all of the forms 
that require 
allocations 
between 
corporations using 
the pre-defined 
form group 
“Allocation 
scenario” in the 
Form Manager. 
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The Calculate button temporarily recalculates that return using the proposed allocation and 
posts the results in the applicable allocation form. 

You can modify the proposed allocations and recalculate the results as many times as 
necessary until you have determined your optimal allocation. 

Step 4 – Save and close the return 
Save and close the initial return in which you established the links and determined the 
allocations.  

Step 5 – Import the data into the remaining returns 
Open the next return in the group. 

Click Import Data/Corporate Group on the File menu. 

Select the return that you updated in Steps 1-4. 

Taxprep will display a list of the related and associated corporations that are part of this 
group.  

Corporations that are already listed in the current file will be shown as existing corporations. 
Any corporations not found in the current list, will be displayed in the New list.  

Clear the check mark beside any corporations that are not related or associated with the 
current corporation. 
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Step 6 – Complete the R&A Workchart for each corporation 
You will need to identify the relationship between any new corporations listed and the filing 
corporation as well as provide any details for the percentage of shares owned by the filing 
corporation for Schedule 9 purposes. 

For existing corporations, this information will be rolled forward from the prior year, but may 
need to be adjusted to reflect any change in ownership. 

Step 7 – Repeat for remaining corporations 
Repeat Steps 5 and 6 for each corporation in the group.  

Changes in Linked Returns 
If any data affecting the R&A Workchart is modified in any of the linked returns after the data 
has been transferred from the original file to other files in the group, you can update the data 
from all of those returns using the command Update Links to Corporations from the Tools 
menu. 

Taxprep will display any data items that differ between the source files and the current file 
that you are viewing. You can select to transfer any or all of the modified data. 

Creating a Taxprep Forms File 
You can use the command Create Taxprep Forms File on the File menu to create a Taxprep 
Forms file and copy the appropriate data from Form Identification, Corporate Identification 
and Other Information (Jump Code: ID) to the Identification form of the new Taxprep Forms 
client file. 

This can be useful in situations where you need to prepare a form or an information return 
that is only available in Taxprep Forms (e.g., Underused Housing Tax return). 
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You can also create a Taxprep Forms client file from the Client Manager. 

Once the Taxprep Forms file has been created, Taxprep Forms will launch automatically so that 
you can prepare the required forms or slips.  

Note: You must have Taxprep Forms installed in order to use this feature. 

Importing and Exporting Other File Types 
Corporate Taxprep also allows you to import and export the following types of files:  

• .csv files (separator: semicolon). This file format contains items from a spreadsheet or a 
database with cells separated by semicolons and can be created with any type of text 
editor. 

• .xls files (worksheet). This type of file is created with Microsoft Excel©. 

For more information on importing and exporting data, refer to the Help. 

Saving Returns 

You must click the  icon to save the data. If you attempt to close the return while there is 
unsaved data, the program will prompt you to save the file prior to closing it.  

The program will also automatically save periodic back-ups of your data files if they contain 
any unsaved data. You can modify the interval at which the back-up files are saved in Options 
and Settings. 

All returns within the data file are saved automatically when the file is saved. 

File name extensions 
The client files created with Corporate Taxprep have a “.2xx” extension, where the “2” 
represents corporate tax and “xx” represents the end of the corporation’s taxation year. 
Taxprep will assign the file extension automatically based on the taxation year. 

Notes to the File 
 

 

 

When you save a file, by default Taxprep 
will display the Properties dialog box. This 
includes a section for Notes that can be 
used to record information about the 
return.  

These notes can be edited and viewed in 
the Client Manager. When rolling forward 
your files, you also have the option to roll 
forward these notes.  
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Attaching External Files 

You can attach any external file to your tax return file by clicking the  icon on the toolbar 
or the Attached Files command on the File menu. This dialog box is also accessible by pressing 
Ctrl + F11.  
You have the option of either saving a link to the selected file or embedding a copy of the 
selected file within the Taxprep data file.  

You can use the Attached files command to attach certain documents to be electronically 
transmitted along with the T2 or CO-17 return as well as the T1134, T106 and T1135 information 
returns and special election forms. See page 31 for more information. You can also use the 
Attached files command to attach a PDF of the signed MR-69 authorization request along with 
a supporting document, if applicable, to be electronically transmitted to Revenu Québec. See 
page 35 for more information. 

While almost any type of file can be attached, you cannot attach file types that are executable 
and could therefore present a security risk (e.g. .exe, .bat, .chm, .js), In addition, if the attached 
file is to be transmitted to the federal or provincial government, there may be further 
limitations on the size and format.  

You can also automatically attach a PDF file generated using any of the print commands in 
Corporate Taxprep.  

For more information on attaching external files, refer to the Help. 

Reviewing Returns 
Once you have entered all of the information into the tax return, you should review the return 
to ensure accuracy. There are several ways of reviewing the return: 

Xpress 
Taxprep Xpress is a tool used to enter and verify data. It offers many filters that enable you to, 
among other things, compare the values entered for this year with those from last year. This 
way you can quickly notice errors or missing information. It also allows you to review 
overridden and marked cells in the return by selecting the appropriate Xpress filter. 

Track Changes 
During the review process, you may wish to monitor any changes made to the return to ensure 
that only the identified corrections are made and that no data is changed inadvertently. 
Activate the command Track Changes on the Edit menu and any changes made to the return 
after that point will be tracked and can be viewed in Xpress using the filter “Data Modified 
after activating Track Changes.”  

Monitor 
The Monitor is a tracking tool that lets you display key tax information at the bottom of the tax 
return window.  
On the View menu, click Monitor to display or hide the monitor. 

 
You can use the Monitor to keep track of any data cell from a return no matter what form you 
happen to be viewing at the time. This allows you to see changes in any calculated values, 
such as tax payable.  
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Certain values will be displayed in the Monitor by default: Net Income, Taxable Income, Part 1 
Tax and Dividend Refund. However, you can customize the Monitor’s contents by adding and 
removing cells as well as adjusting their descriptions, width and display order. 

To add a cell to the Monitor, simply click the cell that you want to view and drag it onto the 
Monitor. 

When you customize the Monitor’s contents, these settings are saved for your workstation and 
will apply to all returns. 

Diagnostics 
You can display the list of diagnostics so that you can consult them as you work on the return. 

To view the list of Diagnostics, click Diagnostics on the View menu or click the  icon on 
the toolbar. You have two options for displaying the diagnostics: Dock and Float. 

If you choose Dock, the list of diagnostics will be displayed in a pane at the bottom of the 
Taxprep window.  

If you choose Float, the diagnostics will be displayed in a separate window which you can 
reposition (e.g. onto a second monitor). 

You can also use the hotkey Alt+F5 to display the docked list of diagnostics and the hotkey 
Alt+F6 to display the floating list of diagnostics. Alternatively, you can access the 
Form Manager and enter the Jump Code DIAG to display the Diagnostics. 

Once the Diagnostics are displayed, you can switch between display modes using the 
icon on the Diagnostics toolbar. 

To display diagnostics directly on a form, point to a cell with a diagnostic’s indicator and the 
diagnostic message will be displayed. This information is available regardless of whether or 
not the diagnostics pane is visible. 

Diagnostics can be printed directly from the Diagnostics pane (either floating or docked) using 
the command File/Print Diagnostics or they can be included in a print format so that they are 
printed along with the return. By default, the Diagnostics will be printed in the Office copy of 
the return. 

Customized Diagnostics 
You can also create your own diagnostics in Taxprep in the view Filters and Diagnostics. These 
diagnostics can be used to check for adherence with firm procedures (e.g. partner name 
entered) or as a reminder for specific data entry requirements or tax issues.  

Any diagnostics that you create that are applicable to the return will appear in the tab My 
Diagnostics on the Diagnostics pane.  

Refer to the Help for more information on how to create custom diagnostics.  
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Review Mode  
When a return is being reviewed, the review mode allows you to add review marks to the 
appropriate cells in the forms simply by clicking them. 

Review marks can be used to identify whether the data is correct or incomplete.  

The following review marks are available:  

Symbol Name of the 
review mark Recommended when... 

 First review The reviewer wants to indicate that the content of a 
cell has been reviewed once. 

 Second review The reviewer wants to indicate that the content of a 
cell has been reviewed a second time. 

 Error The reviewer wants to let a preparer know that the 
content of a cell contains an error. 

 Uncertainty 
The preparer wants to indicate that he or she is 
uncertain of the content of a cell. This mark can also 
be used to represent an estimate. 

 
Other  

The preparer wants to indicate that the content of a 
cell must be reviewed for a reason other than the 
one previously mentioned.  

Note: If you double-click a cell when the review mode is activated, a review mark is added and 
then you can access the source form. 

Review marks are not printed when you use the Print Return command. Review marks can be 
printed using the Print Form command by using the print option Print as displayed. 

 

Reviewing Diagnostics 
You can mark diagnostics as “Reviewed” or “Ignored” by right-clicking on the diagnostic in the 
Diagnostics pane and selecting the desired annotation.  

By default, all diagnostics will appear under the Take Action tab in Diagnostics pane. However, 
once a diagnostic is marked as Reviewed or Ignored, it will no longer appear under the Take 
Action tab but will instead be shown in the Reviewed or Ignored tab, as applicable. 

This allows you to mark any diagnostics that cannot be cleared (e.g. a filing reminder), so that 
upon subsequent review, you will know which diagnostics you have already reviewed. 

Electronic Signatures 
You can use an electronic signature on prescribed forms such as Forms T183 CORP, T2183, 
CO-1000, T1135 and the Representative Authorization Request as well as many other forms that 
may require a signature. 

If your client will be electronically signing Form T183 CORP, Information Return for 
Corporations Filing Electronically, answer Yes to the question Are you planning on using an 
electronic signature method on Form T183? on the form and provide the e-signature date and 
time in the fields indicated. This information will be transmitted with the T2 return.  

 TIP 
The review mode 
can be used from 
the Xpress tool. 

mk:@MSITStore:C:%5CProgram%20Files%5CCCH%5CT1%20Taxprep%202006%5CHelp%5CTP1%5CTxpTechE.chm::/ReviewMarkAdd.htm
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To streamline your signature process, built-in tags have been integrated into various forms to 
indicate where the digital signature must be affixed. If you are using CCH iFirm Portal, these 
tags allow you to streamline the publishing of forms that require your customer’s digital 
signature. The CCH iFirm Portal integration will also automatically update the above-
mentioned e-signature date and time fields.  

For more information, refer to the Help Centre for Corporate Taxprep and/or the Help Centre 
for CCH iFirm Portal. 

Printing 
Printing Forms 
Printing a single form 
In the Tax Return view, you can print individual forms for any of the active returns.  

1. On the File menu, click Print Form to print the current form that is on screen.  

Note: When you use the Print Form command on a multiple copy form (e.g. CCA Workchart), 
only the current copy will be printed. To print all copies of a multiple copy form, select the 
entry on the Form Manager and then click Print Selected Form(s).  

Printing several forms 
To print more than one form at the same time (but not necessarily the whole return), proceed 
as follows: 

1. Select the desired forms on the Form Manager.  
2. On the File menu click Print Selected Forms. 
3. Click OK to start printing. 

Note: When viewing a form, the print command is called Print Form. When on the Form 
Manager, the print command is called Print Selected Forms. 

Form Printing Options 
You can select a number of options when printing individual forms: 

• Print to PDF file 
• Print a blank copy of the selected form(s).  
• Override the date to be printed on the form(s). 
• Page range to be printed (single form only). 
• Print a watermark on the form(s). 
• Use zoom printing to print more than one page per sheet of paper 
• Select the language in which the form will be printed 

You can also click the Options button to modify any of the print settings previously configured 
under Options and Settings. 

Printing the Notice of Assessment  
If you have downloaded a Notice of Assessment (NOA) through TaxprepConnect (see page 18), 
as an alternative to printing the NOA from your browser, in the Tax Return view, you can click 
Print NOA on the File menu to print the NOA either directly to your printer or to a PDF file.  

Printing Returns 
You can print the returns included in the current client file using any of the following three 
methods: 
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• On the File menu, click Print Tax Return. 
• From the Form Manager, right-click and then click Print Tax Return on the shortcut menu. 
• Press Ctrl+R. 

Viewing Diagnostics 
When you select the command Print Tax Return, and there is at least one diagnostic that 
needs to be corrected, the diagnostics will be displayed automatically prior to printing.  

Click Continue if you want to proceed with printing the return.  

Selecting Returns 

 
A different icon is used to represent each of the corporate income tax returns that may be 
required: 

• Federal returns and schedules (includes the capital tax returns for provinces other 
than Québec and federal information returns) 

•  Québec CO-17 return 

•  Alberta AT1 

You can select which returns you want to print by selecting the appropriate check box. 

Note: The selection of what will be printed for each copy of the return is saved in a template 
file called “Print Format.” For more information on customizing print formats, refer to the 
Help. 

All of the available print formats will be listed. You can change which print formats are 
selected by clicking the appropriate check boxes.  

All selected print formats will be produced for each return. (e.g. a client copy, EFILE documents 
and an office copy will be printed).  

If you want to generate a PDF file instead of printing a hard copy, select the PDF box.  

You can select a different watermark for each copy. 

Click Options to change any of your configured print options prior to printing.  



Corporate Taxprep   Quick Start Guide 

29 

PDF Printing 
When generating PDF files, you can apply a password automatically to the generated PDF. This 
helps ensure that the returns remain secure (e.g. when sending copies via e-mail). You can 
also configure the file naming convention for the PDF files generated. These options can be 
configured in advance using the command Options and Settings on the Tools menu, or 
immediately prior to printing using the Options button in the Print Return dialog box. 

T2 Return and Bar Codes 
The CRA requires that a computer generated T2 return that is not being filed electronically, be 
submitted in a format called T2 Bar Code Return. The “GOVT-RSI, Bar Codes – RDA, code à 
barres” print format has the T2 Bar Code Return set to print automatically whenever it is 
applicable. 

The T2 forms that appear on screen resemble the T2 forms available from the CRA. These are 
the T2 forms that are set to print in the “Client” and “Office” print formats. 

Note that bar codes forms cannot be printed if any mandatory information is missing from the 
return. Verify the RSI-Bar codes tab in the diagnostics to identify any errors. 

Printing the Québec CO-17 
The Québec CO-17 return can only be filed in French. The “GOVT-RSI” print format has an 
option enabled to automatically print the CO-17 return in French regardless of which language 
is used to print the rest of the return. In the “Client” and Office” print format, the CO-17 return 
will print in the same language as the rest of the return. 

The information in the Québec CO-17 return is included in one or more two-dimensional bar 
codes which are printed on Form COR-17.U, Corporation Income Tax Return Data. 

Filing Requirements 
To view a complete list of filing requirements for the federal and provincial returns, refer to 
the Filing Requirements topic in the Help. 

Printing Returns from Multiple Files 
If you want to print returns from multiple data files, select the returns on the Client Manager 
then click Print Tax Returns as you would for a single file. 

EFILE 
Most federal T2 returns, Québec CO-17 returns and Alberta AT1 income tax returns can be 
electronically filed.  

In addition, the following federal information returns and special election forms can be 
electronically filed: 

• RC4649 – Country-by-Country Report 

• T106 – Information Return of Non-Arm’s Length Transactions with Non-Residents 

• T1134 – Information Return Relating to Controlled and Not-Controlled Foreign Affiliates 

• T1135 – Foreign Income Verification Statement 

• Schedule 89 – Request for Capital Dividend Account Balance Verification 

• T2054 – Election for a Capital Dividend Under Subsection 83(2) 

You can also transmit certain attachments with T2 and CO-17 returns as well as supporting 
documents for the T106, T1134 and T1135 information returns, Schedule 89 and the T2054 form. 
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The information returns can be transmitted at the same time as the T2 return or they can be 
transmitted separately (e.g. where the return is not due at the same time as the T2 return).  

Mandatory EFILE 
Corporate tax returns are subject to two different kinds of mandatory EFILE. 

Federal T2 and Québec CO-17 returns for prescribed corporations (e.g., with revenue greater 
than $1 million) must be electronically filed or the corporation will be assessed a penalty of 
$1,000 for each return.  
Effective for taxation years that begin after 2023, subsection 205.1(2) of the Federal Regulation, 
which defines a “prescribed corporation”, was amended to remove the reference to 
corporations with gross revenue exceeding $1 million. As a result, all corporations are now 
required to file their federal return of income electronically under subsection 150.1(2.1) of the 
Act, except for insurance corporations, non-resident corporations, corporations reporting in 
functional currency, or corporations exempt from tax under section 149 of the Act.  

For year ends after 2017, this penalty may also be applied for failure to electronically file an 
Alberta AT1 return for a prescribed corporation.  

Corporate Taxprep will identify the corporations that are subject to mandatory EFILE and will 
display a diagnostic if the return is not selected for EFILE. 

In addition, tax preparers who prepare corporate tax returns for remuneration may be subject 
to a penalty of $100 for failure to electronically file a T2 return, a Québec CO-17 return or an 
Alberta AT1 returns. Tax preparers may paper file up to 5 returns without penalty (prior to 
2024, this threshold was 10 returns).  

Setup 
To set up EFILE proceed as follows: 

1. On the Tools menu, click Options and Settings and complete the “Electronic Services” 
section.  

2. In the Preparer Profile, complete the EFILE tab. 

Note: If you are electronically filing in a network environment, refer to the Help for additional 
instructions on how multiple users can access the transmission information. 

Transmitter Numbers 
For federal Corporation Internet Filing (CIF), you will require either an EFILE number and 
password (the same number and password used to transmit T1 returns) or a Web Access Code 
(WAC) in order to transmit your return. 

Your EFILE number and password must be entered in the “Electronic 
Services/Identification/Federal” section of the Options and Settings dialog box.  

The WAC can be obtained through an online request using Form WAC, Online Request to get a 
Web Access Code (Jump Code: WAC). You can also make the request at the time of transmission 
from within the Transmit dialog box. 

A new WAC must be obtained each tax year. 

The WAC can also be used to transmit an RC4649 Country-by-Country Report. 

In order to transmit your Québec CO-17 returns, you will require either a NetFile Québec 
number and password (same number and password used to transmit TP1 returns, if 
applicable) or you must obtain a Clic Revenu number and password through the Revenu 
Québec Clic Revenu service. 
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Your user code and password must be entered in the “Electronic 
Services/Identification/Québec” section of Options and Settings. 

No transmitter number is required for Alberta Net File. 

The electronic filing of the T106, T1134, T1135 information returns, special election forms (e.g., 
Schedule 89 and Form T2054) and the transmission of any supporting documents, as well as a 
Representative Authorization Request or Cancellation all require an EFILE number and 
password. You cannot use a WAC to transmit these information returns, special elections, 
supporting documents or consent forms.  

Selecting Returns and Forms 
Before a return or form can be electronically transmitted, it must be selected for EFILE.  

By default, all applicable income tax returns, information returns and consent forms will be 
selected for EFILE. However, in the Tax Preparer’s Profile, for each type of return or form, you 
can disable the option that automatically selects that type of return or form for EFILE.  

For the income tax returns, you can modify whether or not the specific T2, CO-17 or AT1 return 
is selected for EFILE on the RSI – EFILE- Bar codes, RSI, Electronic Filing and Bar codes Control 
Workchart (Jump Code: RSI-EFILE-Bar codes). 

For the information returns, special elections and consent forms, you can modify whether or 
not that return or form is selected for EFILE on the specific return (e.g., T1134). 

Checking EFILE Eligibility 
Once a return has been selected for EFILE, the program will determine if the return is eligible 
for EFILE.  

The program designates a return’s EFILE status as "Eligible" when the return: 
• has been selected for EFILE;  
• meets the eligibility requirements; and 
• includes all of the required data as specified by the applicable government. 

To verify if a return satisfies EFILE eligibility requirements, display the Diagnostics pane, then 
click the T2 EFILE tab to verify EFILE diagnostics. 

Note: The diagnostics are only generated after the return has been selected for EFILE. 

Notes to the Financial Statements 
The notes to the financial statements are included in EFILE transmission. They must be 
provided to the CRA in plain text format in the Form General Index of Financial Information 
(Jump Code: NOTES).  

You cannot transmit tables, graphs or other image files.  

Any Notes to the Financial Statement entered in the Notes form for the federal return will also 
be transmitted automatically to Revenue Québec along with the CO-17 return. 

Supporting Documents 
When electronically transmitting T2 or CO-17 returns as well as the T106, T1134 and T1135 
information returns and special election forms Schedule 89 and Form T2054, you can also 
transmit certain supporting documents that you would otherwise have to provide to the 
government. 

To transmit a supporting document, the document must first be attached to the return using 
the Attached Files command (see page 24). When you attach a document, you will be 
presented with the Attached files properties dialog box. Select the type of return the 

 TIP 
You can avoid re-
typing the 
financial 
statement notes 
by using the 
Windows copy 
Ctrl+C and paste 
Ctrl+V commands 
to copy them from 
your word 
processing 
program to the 
Notes form. 

mk:@MSITStore:C:%5CProgram%20Files%5CCCH%5CT1%20Taxprep%202006%5CHelp%5CTP1%5CTxpEfileE.chm::/EFILE_SelectReturns.htm
txpteche.chm::/DocumentStatus_EFILE.htm
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document is supporting (e.g., T1134). The document will then be validated to ensure that the 
format and size are acceptable for the type of transmission selected.  

Where applicable, select the type of document (e.g., financial statements). In the case of the 
T2, only certain T2 supporting documents are eligible for transmission. In the case of the T1134 
and T106, you must also indicate if the document is related to the Summary or a specific 

Supplement or Slip. Click the icon to view a list of the relevant supplements/slips and 
select the appropriate one. For T2 supporting documents, you are required to provide a brief 
description of the supporting document. 

Note that the directors’ resolution must always be attached in support of Form T2054.  

Once all the required information has been provided, the document will be assigned an EFILE 
status of Eligible. Only documents with an EFILE status of Eligible will be transmitted with the 
return. If there are any supporting documents with the EFILE status Not Eligible, you will not 
be able to transmit the supporting documents for that return.  

Note that you can change these settings at any time by clicking the  icon to the right of the 
attached document. However, once a supporting document has been transmitted and 
accepted, you will not be able to modify the document properties.  

You can attach multiple supporting documents to be transmitted with a given return. However, 
if you attach multiple supporting documents for a CO-17 return, they will be combined into a 
single PDF at the time of transmission.  

The Transmission column in the Attached Files dialog box will indicate which return the 
document will be accompanying.  

 

Transmission of Supporting Documents 
Supporting documents for the CO-17 return must be transmitted at the same time as the CO-17 
return.  

Supporting documents for the T2 can be transmitted at the same time as the T2 return or 
within 24 hours of the T2 return having been accepted. Similarly, supporting documents for 
special elections (e.g., the directors’ resolution for Form T2054) must also be transmitted 
within 24 hours of acceptance of the form. 

Supporting documents for information returns can either be transmitted at the same time as 
the relevant information return or at a later time, provided the information return has been 
accepted.  

You can also transmit supporting documents for these information returns more than once 
(e.g., if additional documents become available after the initial documents are sent).    

For more information on transmitting supporting documents, refer to the Help. 
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EFILE Authorization 
If you are transmitting the return on behalf of a corporate client, then you will require a copy 
of the Form T183 CORP, Information Return for Corporations Filing Electronically (Jump Code: 
T183) signed by an authorized signing officer of the corporation prior to transmitting the 
return.  

Similarly, if you are transmitting a CO-17 return to Revenu Québec using your NetFile Québec 
number, an authorized signing officer must sign Form CO-1000 (Jump Code: Q1000).  

If you are transmitting a special election on behalf of a corporate client, you will require a 
copy of Form T2183, Information Return for Electronic Filing of Special Elections (Jump Code: 
T2183) signed by an authorized signing officer of the corporation prior to transmitting the 
return.  

As described on page 26, these forms may be signed electronically.  

AT1 Net File Authorization 
While there is no comparable form to the T183CORP for Alberta Net File, information about the 
transmitter is included in the transmission file and the transmitter must make a declaration of 
authorization at the time of transmission.  

The Alberta EDI schedule (Jump Code: AEDI) displays information about the filer and the 
person to contact with regards to electronic filing of an Alberta tax return. 

Transmitting Returns and Supporting Documents 
A return, as well as applicable supporting documents, can be electronically transmitted from 
either the Tax Return view or the Client Manager view.  

Transmitting the Active Return(s) and Supporting Documents 
On the Transmission menu, click Transmit.  

All of transmittable returns and supporting documents in the client file will be listed and the 
returns and supporting documents with the EFILE status Eligible, will be selected by default. 
You cannot select or transmit a return or supporting documents with an EFILE status other 
than Eligible. If there is an eligible return or supporting documents that you do not want to 
transmit at this time, you can clear the selection box for that return.  

Note: Depending on the contents of the client file, you may need to scroll to the right to see 
all of the potential transmissions associated with that client’s file. 

Click OK to transmit the return(s). 

Terms and Conditions 
When you transmit a T2 return to the CRA, you are required to read and agree to the terms and 
conditions of the Corporation Internet Filing online transmission in order to transmit your T2 
return. A dialog box will therefore appear at the time of transmission, listing the terms and 
conditions. You must select the box to indicate that you agree in order to continue the 
transmission.  

This acceptance must be done for each return transmitted. 

In addition, if the program detects one or more AT1 returns to transmit, you will have to 
certify, for all transmitted Alberta returns, an Alberta TRA declaration of responsibility stating 
that the return(s) meet the requirements and that you are authorized to transmit them.  
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Confirmation of acceptance 
When a return is transmitted, the government does a preliminary check of the return. If the 
return meets the basic requirements, they will confirm whether or not the return has been 
accepted for processing within seconds. 

The EFILE Transmission Results dialog box is displayed automatically once the returns have 
been transmitted. It lists the returns that have been transmitted and provides a confirmation 
number for each accepted return or an error message for any rejected returns. 

Use the Print button at the bottom of the dialog box to print the list for your records. You can 
also view the transmission results for any returns transmitted from your workstation by 
clicking EFILE Transmission Results on the Transmission menu. 

The corporation name, business number, taxation year end and date of confirmation as well 
as the confirmation number can be viewed on Form EFILE Information (Jump Code: EFILE INFO). 

A separate confirmation number will be provided for each return or form transmitted. The 
Form EFILE Information contains a separate section for each type of return and form that can 
be electronically transmitted.  

 

 
If the tax authority accepts the return or form for processing, then the program will 
automatically change the EFILE status of that return or form to Accepted. 

Correcting the Return 
If the return or form is not accepted by the CRA, Alberta Tax and Revenue Administration or 
Revenu Québec, then Taxprep will set the applicable EFILE status of the return or form to 
Rejected and will record the error message received in Form EFILE Information (Jump Code: 
EFILE INFO). 

When a return that has an EFILE status of Rejected is recalculated, the EFILE status will be 
automatically determined again based on the current data in the return and if applicable, the 
EFILE status will be reset automatically to Eligible. While Taxprep automatically recalculates 
the return whenever data is modified, you can also force a recalculation without changing any 
data using the command Recalculate (Ctrl+F9) on the Tools menu.  

Note that as the problem that gave rise to the rejection was not detected by Taxprep prior to 
transmission, you must ensure that the modifications made to the return will rectify the 
problem. Otherwise, the return could still be rejected even though the EFILE status is Eligible. 

T2 Supporting Documents 
Note that if the T2 return is rejected, then any T2 supporting documents will not be 
transmitted and the EFILE status of these documents will remain Eligible.  
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Electronic Filing of Authorization Requests  
Federal Authorization 
You can electronically transmit a request for authorization to represent a client for CRA 
purposes on Form AUTHORIZATION, Authorizing or Cancelling a Representative (Jump Code: 
AUTHORIZATION) as well as a Request to Cancel Authorization for a Representative (Jump Code: 
Cancellation) 

The configuration of this service is the same as the EFILE (federal), i.e., you must specify your 
EFILE number and password (provided by the CRA).  

You can only EFILE the authorization if you are requesting Online Access and have already 
registered as a representative.  

Similar to the electronic transmission of information returns, an Authorization Request or 
Cancellation Request is a separate transmission from the T2 return. While it can be 
transmitted at the same time as the T2, similar to an electronically filed Information return, 
normally it would be transmitted in advance of the preparation of the return, for example, to 
obtain authorization to download data for the client using TaxprepConnect. 

The Representative Authorization Request is transmitted using the same Transmit command 
that is used to electronically transmit the tax and information returns (See the “Transmitting 
Returns and Supporting Documents” section on page 33). 

As of October 2022, after you transmit an authorization request, the request will go into a 
“pending” state. The request will not be activated until the business owner or their delegate 
logs into My Business Account and clicks on the “confirm pending authorizations” button in 
the Authorized Representatives section. For more information, refer to the topic “Confirm my 
representative’s authorization request” on the CRA Web site: 
https://www.canada.ca/en/revenue-agency/services/tax/representative-
authorization/confirm-representative.html. 

Note that authorization requests transmitted using Corporate Taxprep are valid for all 
business types, not just incorporated businesses. 

Cancellation Request 
As of October 21, 2024, the CRA will only accept the transmission of a request to cancel your 
own authorization. You cannot transmit a request to cancel authorizations for other 
representatives. If your client wishes to cancel their authorization for a past representative, 
they will need to do this via My Business Account. 

If you wish to make a change to an existing authorization (e.g., change the programs 
authorized or the level of authorization), you will need to cancel the existing authorization and 
request a new authorization.  

The program allows you to file a Representative Authorization Request and a Request to Cancel 
Authorization for a Representative at the same time. However, to prevent the cancellation of 
an authorization request transmitted during the operation, the program will first file the 
cancellation request before electronically filing the Representative Authorization Request, so 
that the CRA will first cancel any previously given authorization and then process the new 
representative authorization request. 

Québec Authorization 
Starting with Corporate Taxprep version 2022 1.0, you are also able to transmit an MR-69 
authorization request to Revenu Québec.  

In order to transmit an MR-69, you must have a NetFile number and password and be 
registered as a professional preparer. Your professional preparer number will be required on 
the MR-69 in order to electronically transmit the form.  

https://www.canada.ca/en/revenue-agency/services/tax/representative-authorization/confirm-representative.html
https://www.canada.ca/en/revenue-agency/services/tax/representative-authorization/confirm-representative.html
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In addition, Revenu Québec requires that a PDF of all four pages of the signed Form MR-69 (or 
5 pages if it is electronically signed) be transmitted along with every authorization request.  

Once the MR-69 form is completed in Corporate Taxprep, it should be printed and signed by 
the taxpayer. Then a PDF of the signed copy of the MR-69 should be attached to the return 
using the Attached Files command (see page 24). The file name cannot exceed 60 characters 
and cannot contain spaces or special characters (including accented letters).  

In the Attached files properties dialog, select the check box for MR-69 in the Transmit with: 
column on the left-hand side of the dialog. You will then need to select the type of document. 
Select Signed Copy if you are attaching the PDF of the MR-69 that your client has signed.  

In addition, when the signing officer is not one of the executive officers (e.g., president, vice 
president, secretary or treasurer), Revenu Québec will require documentation to substantiate 
the authority of the signatory to provide authorization. In that case, an additional document 
should also be attached to the client file for transmission with the MR-69. Follow the same 
procedures outlined above, selecting the appropriate type of document.  

As Revenu Québec will only accept a single supporting document in addition to the signed 
MR-69, all supporting documents should be merged into a single PDF, JPEG or TIFF file. 

Once all the required information has been provided, the document will be assigned an EFILE 
status of Eligible. Only documents with an EFILE status of Eligible can be transmitted with the 
MR-69.  

Transmitting an Authorization Request (Federal and Québec) 
EFILE Status 
The section Electronic Filing – Checklist at the top of the federal form Authorization and/or 
the Québec MR-69 is used to determine whether or not an authorization request will be 
eligible for EFILE. 

All of the questions in the Checklist must be answered Yes in order for the authorization 
request to be eligible for EFILE.  

Note that as the client must sign the Authorization request prior to transmission, you must 
print the Authorization request signature page or the MR-69 either to a printer or as a PDF in 
order for the authorization request to be eligible for electronic filing. 

In addition, an MR-69 request will only be eligible for electronic transmission once the signed 
copy of the MR-69 has been attached to the return as described above. 

The information on the transmission status of the authorization request is also available using 
the File/Properties command (F11). 

Transmission of one or more Authorization requests 
The authorization request can be transmitted individually or in batch. You can use the Client 
Manager to select multiple client files and transmit the Authorization request for the selected 
files at the same time.  

To transmit one or more Authorization requests, proceed as follows: 

1. On the Transmission menu, click Authorization. 
2. The Transmit dialog box displays. By default, any “Eligible” Federal or Québec 

authorization requests in the client file will be selected for transmission. 
3. Clear the box for the authorizations requests you do not want to transmit. 
4. If an authorization (federal or Québec) for one or more clients is not eligible for an 

authorization request transmission (e.g., the federal Authorization has an EFILE status 
of Eligible, but the MR-69 EFILE status is Not Eligible), the applicable check box will not 
be selected and you will be unable to select it for transmission of the authorization 
request.  
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5. Click OK to transmit the selected authorization requests. For federal authorization 
requests, you will be required to confirm that the taxpayers have signed the 
authorization request prior to transmission. 

For more information on electronically filing an Authorization request, refer to the Help. 

Amending Returns 
T2 Returns 
If you discover a mistake and wish to adjust the return after it has been assessed, you can file 
a request for reassessment (also known as “filing an amended return”). 

This request can be made electronically, by transmitting the revised T2 return, or by paper 
filing a T2 Bar Code return. 

In either case, you will need to answer “Yes” to question 997 on the Identification form to 
indicate that this is an amended return. You must then provide details of the changes being 
requested on the form provided for line 996.  

 
Note that you can also transmit supporting documents with an amended T2 return. However, if 
the documents have already been transmitted to the CRA, do not transmit them again with the 
amended return unless there have been changes to the documents.  

CO-17 Returns 
You have two options for requesting a reassessment for a Québec CO-17 return:  

1. Electronically file an amended CO-17 return; 

2. Paper-file Form CO-17.R, Request for an Adjustment to a Corporation Income Tax Return 
or to an Information and Income Tax Return for Non-Profit Corporations (Jump Code: 
QJR) to request an adjustment to a CO-17 return along with the appropriate supporting 
documents, including a copy of the revised CO-17 return. 

Electronically filing an Amended CO-17 Return 
The program will transmit a complete amended CO-17 return with the desired changes, similar 
to transmitting an amended T2 return. Note, however, that even though Form CO-17.R is not 
transmitted, the program will use this form to track the adjustments being made. 

If you electronically transmitted the original CO-17 return, by default, when you indicate that it 
is an amended CO-17 return on Form Corporate Identification and Other Information (Jump 
Code: ID), the program will answer “Yes” to the question Is the return an amended return? (Box 
24 on the CO-17 return), as well as answering “Yes” to the question Do you want to 
electronically retransmit the amended CO-17 return instead of mailing a CO-17.R form? at the 
top of Form CO-17.R. At that point, the EFILE CO-17 status will no longer be “Accepted,” and you 
will then be able to amend the return and make the desired changes. The amended return can 
then be transmitted in the same manner as the original return. 
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You can transmit an amended CO-17 return even if the original return was paper-filed. 
However, the EFILE exclusions that apply to the transmission of original CO-17 returns also 
apply to the transmission of amended returns.  

If you are an accredited person transmitting on behalf of a corporation (e.g.an accounting 
firm), your client must sign a copy of Form CO-1000.TE providing authorization for you to 
electronically transmit the amended return. 

Once the transmission is accepted by Revenu Québec, the confirmation number and the date 
the transmission was accepted will be saved in Forms CO-17.R and EFILE INFO, EFILE 
Information (Jump Code: TED INFO). For more information on filing amended CO-17 returns, 
refer to the Online Help.  

 

AT1 Returns 
To transmit an amended AT1 return, you must answer “Yes” to the question on line 071, Is this 
an amended Alberta tax return? on Form AT1 EDI Schedule – Alberta Electronic Data 
Interchange (Jump Code: AEDI). If you answer “Yes” to the question Is this an amended Alberta 
tax return? in the “Amended tax return” section of Form Identification, Corporate Identification 
and Other Information (Jump Code: ID), this answer will be updated to line 071 of the AEDI 
form. 

You must also provide the filing date and, on line 073, enter a brief description (maximum 100 
characters) of the changes being made in the amended return. 

 
Alternatively, you can submit a letter along with the revised schedules to Alberta Finance to 
request a reassessment of an Alberta AT1 return. 

Information Returns  
To transmit an amended T1134, T1135 and T106 information return, select the appropriate 
check box on the relevant information return indicating that it is an amended return, then 
retransmit the return. You may also transmit supporting documents for amended returns.  

Program Help 
The following Help resources are available: 

Tax and Form Help 
Context-sensitive tax help is easily accessible from each cell by pressing F1 or by clicking 
Corporate Taxprep Help on the Help menu.  

The Help Centre is online and requires Internet access. The Help Centre includes information 
about using the program, completing the tax forms, electronic services, FAQ’s, Troubleshooting 
and Release Notes. It also includes links to many CRA and provincial guides. 

Knowledge Base  
Our Knowledge Base contains an array of articles answering technical and tax questions most 
frequently asked to Support Centre agents. When you enter a few key words in the Search 
field, articles will be displayed in order of relevance, providing you with valuable information 
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that will accurately answer your questions. You can use the filters on the left side of the 
screen to filter the results by product.  

You can access the Knowledge Base from the Help Centre or directly from the 
Professional Centre. 

InfoConnect Tax Hints 
Cells with a blue triangle in the bottom right corner have a direct link to a relevant section in 
the appropriate Tax Research title. 

If you have a subscription to the applicable Wolters Kluwer Tax Research product, and you 
have this option enabled, then when you hover your pointer over the cell, an InfoConnect tax 
hint will appear displaying the relevant tax hint. The tax hint consists of an excerpt from a tax 
research product. You can then click the Learn More link at the bottom of the hint to access 
the full topic in CCH AnswerConnect® or CCH IntelliConnect®.   

For the majority of cells in Corporate Taxprep, the link will be to a relevant section of the 
Income Tax Act.  

 
You can also view the InfoConnect tax hint by clicking the Tax Research button on the toolbar 
or by pressing Shift+F1.  

The display of InfoConnect can be enabled under Tools > Options and Settings > Options > Tax 
Research.   

The display of the InfoConnect tax hints can be disabled by clicking Hide at the bottom right 
corner of the hint. 

 

Technical Help 
To get help on the operation of the program (as opposed to the tax forms), access the Help 
Centre by clicking Corporate Taxprep Help on the Help menu and then use the Search function 
to find relevant help topics. You can also click the Help button in the various dialog boxes. 

 

Training 
You can find information about current training opportunities by clicking Get Taxprep Training 
on the Help menu. 
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